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1. OVERVIEW  

The 7780MUX8x2-ASI is a compact, affordable DVB and ATSC re-multiplexer. The 7780MUX8x2-ASI 
offers on-board stream processing, such as PID re-mapping, program add and drop, DVB or ATSC 
basic table regeneration and creation, and externally generated program guide insertion. The 
7780MUX8x2-ASI offers basic input monitoring to ensure the incoming signals are properly MPEG-2 
framed. 
 
The user can select which incoming programs will be used on the output. The 7780MUX8x2-ASI fits in 
the 7700 chassis and only occupies three slots. Seven independent 7780MUX8x2-ASI can be fitted in a 
single 3RU Chassis. The 7780MUX8x2-ASI is controlled through VistaLINK®-Pro via SNMP commands. 
 
Features:  

• 8xASI inputs per TR101 891 
• 2xASI outputs (Mirrored) 
• Support 188 and 204 Bytes packets on inputs and outputs 
• Support MPEG-2 Video as well as H.264 
• Monitoring of ASI inputs 
• Display of transport stream tree and bitrate 
• Basic MPEG table insertion 
• DVB table insertion through ASI or external IP input 
• ATSC table insertion through ASI or external IP input 
• Status view, configuration through VistaLINK® PRO® 
• Fits in 7700 Chassis 
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Figure 1-1: 7780MUX8x2-ASI Block Diagram  
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2. INSTALLATION  

The following materials are required to successfully install the 7780MUX8x2-ASI: 
 

1. Unused IP addresses on the network or a DHCP server 
2. Evertz serial cable 
3. VLPro Server IP address 

 

2.1. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn. 
 
Locate on a 7700 chassis three adjacent vacant slots. Unpack the 7780MUX8x2-ASI and separate the 
rear panel from the main card. Locate on the rear of the rack the three slots and remove the blanking 
panels. Insert the rear panel into the back of the chassis and secure using the six screws provided.  
 

 
Figure 2-1: 7780MUX8x2-ASI Rear Panel 
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Figure 2-2: 7700 Chassis 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780MUX8x2-ASI card into the corresponding front slots ensuring the card lines up with 
the slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that 
when it mates with the rear panel that is has been firmly pushed into a seated position. This can be 
confirmed when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables 
to the rear panel (failure to do this could cause unwanted network issues) until the initial configuration 
has been completed. 

 
Figure 2-3: COM Properties Window 

 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
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Click OK to apply these settings and press the enter button on your keyboard. The session should 
respond by displaying the 7780MUX8x2-ASI Main Menu, as shown in Figure 2-4:  
 

 
Figure 2-4: HyperTerminal Main Menu 

 
(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) Setup Re-Multiplexer Parameters 
This sub-menu is used to configure the re-multiplexer parameters. As this configuration can also be 
performed via VLPro this sub-menu will not be covered in this section. 
 
(4) Utilities 
This sub-menu contains two utilities. One command is for clearing the memory and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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(5) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before it is possible to configure the card via VLPro, it is first necessary to configure the initial basic 
network settings via the serial cable. See section 2.2.  
 

2.2. CONFIGURING THE BASIC NETWORK SETTINGS 

Now select option (1) Network Configuration, the Network Configuration menu will be displayed as 
shown in Figure 2-5. If you prefer to use DHCP then you may select option (5) Use DHCP, and then 
continue from step 4: 

1. Select option (1) Set IP Address and configure the IP address for the 7780MUX8x2-ASI 
ensuring that the IP address is not already in use on the network.  

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit from the Network Configuration menu using the (S) Save and Exit option, NOT (x) Exit. 

 

 
Figure 2-5: Network Configuration Sub-Menu 

 
5. From the Main Menu select option (2) SNMP Configuration. Select option (1) Set IP Address 

and enter the IP address of your VLPro Server.  Exit using the (S) Save and Exit option, now 
extract the card from the rack, remove the serial cable and re-insert it. 

 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
panel when ready. 
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2.3. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780MUX8x2-ASI jar file to the server and both the client and 
server applications have been restarted. If you are the network administrator refer to section 5.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
The 7780MUX8x2-ASI should appear as a newly listed device with the IP address used to configure the 
card in Step 1 of section 2.2. It may take up to a minute to appear while the card and switch negotiate 
network settings (this can be verified directly on the switch, if necessary). 
 

 
Figure 2-6: VistaLINK® PRO Navigation Tree 

 

 

Note: If after a couple of minutes the card has still not appeared try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. CONFIGURATION 

The 7780MUX8x2-ASI card can be configured using VistaLINK® software.  Once the card is connected 
to VLPRO as described in section 2.3, right click the IP address, selected earlier, of the 7780MUX8x2-
ASI.  When the drop down menu appears, select the “View Configuration…” option.  
 

 
Figure 3-1: Select View Configuration 

 
As shown in Figure 3-2, the Mux configuration screen will appear. The 7780MUX8x2-ASI can be 
configured using the tabs in Figure 3-2.  Refer to section 3.1 and 3.2 to identify the configuration items 
and their functions.  Figure 3-2 also displays the Frame Status tab, however, the frame status is 
currently not active.  
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Figure 3-2: Mux Configuration 

 



7700 MultiFrame Manual 
7780MUX8x2-ASI MPEG-2 Re-Multiplexer 

7780MUX8x2-ASI  - 10 Revision 1.1  

3.1. INPUTS 

The 7780MUX8x2-ASI has eight ASI-inputs and one IP-input labelled External Table Input.  To view the 
content of any input, select the desired input number from the Input folder side panel.  Once the desired 
input has been selected, the settings for that input will be displayed in the General Input Settings tab, 
as shown in Figure 3-3.  
 

 
Figure 3-3: General Input Settings Tab 

3.1.1. General Input Settings 
Input Bit rate:  This field identifies the current bit rate of the ASI input stream.  
 
Input Status:  This field displays the input status. The available options are either active or 

inactive. 
 
Input Source Type:  This field displays the source type of the input. The options are either ASI or 

Ethernet. 
 
Input Mode:   This field sets the input mode. The available options are ATSC, DVB and MPEG.  
 

 
In order to avoid conflict of PIDS, it is important to select the standard to which 
the stream is being coded. 
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Input Packet Size:  This field displays the input packet size.  The options will be either 188 Bytes or 
204 Bytes. 

 

3.1.2. Input buttons 
Close Input:   This button enables the user to close the input window view. 
 
Refresh:  This button enables the user to recapture and display the content of the ASI 

stream. 
 
Add PID:   This button enables the user to add an individual PID to the stream.  
 
3.2. OUTPUTS 

The 7780MUX8x2-ASI has one configurable output, as shown in Figure 3-4.  To view the content of 
Output 1, select Output 1 from the Output folder side panel. When the output is selected the output 
settings will be displayed in the Config Output tab, as shown Figure 3-4. 
 

 
Figure 3-4: Displays Configuration Input and Output Settings 
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3.2.1. Config Output Tab 
Output Bitrate:   This field enables the user to change the output bitrate. The user can use the 

standard output rate for DVB-C, ATSC/SCTE or specify a custom output bit 
rate. 

 

 
The value of the output bit rate must equal the sum of the bit rate of the PIDS 
that are being added to the output 

 
Output Used Bit Rate:  This field displays the actual output bit rate that is being used. 
 
Output TS ID:  This field displays the output transport stream ID.  The default setting is 1. 
 
Output Packet Size:  This field displays the output packet size.  The options will be either 188 Bytes 

or 204 Bytes. 
 
Output Mode:  This field sets the output mode. The available options are ATSC, DVB and 

MPEG. 
 
Output Table Source:  The output tables related to the stream will be created by the MUX if None is 

selected, or they may be added to the output stream from an external source 
originating from one of the eight ASI inputs or the Ethernet input.  

 

3.2.1.1. Config Output buttons 
Clear:  This button clears the output configuration window 
 
Remove Selected:   This button removes a selected PID.  
 
Refresh:  This button refreshes the output configuration window 
 
Apply:  This button applies the output Mux configuration.  
 
Save:   This button saves the configuration to the MUX flash memory. 
 
Load:  This button loads the previously saved configuration from MUX flash memory. 

 

3.2.2. Active Output Tab 
The Active Output tab displays the content of the outputted ASI stream. For real time monitoring of the 
output ensure that Auto Refresh – ON is selected. 
 
Output Bitrate:   This field enables the user to change the output bitrate. The user can set the 

standard output rate to DVB-C, ATSC/SCTE or specify a custom output bit 
rate. 

 

 
The value of the output bit rate must equal the sum of the bit rate of the PIDS 
that are being added to the output 
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Output Used Bit rate:  This field displays the actual bit rate being used. 
 
Output TS ID:  This field displays the output transport stream ID. The default setting is 1. 
 
Output Packet Size:  This field displays the output packet size.  The options will be either 188 Bytes 

or 204 Bytes. 
 
Output Mode:  This field sets the output mode. The available options are ATSC, DVB and 

MPEG. 
 
Output Table Source:  The output tables related to the stream will be created by the MUX if None is 

selected, or they may be added to the output stream from an external source 
originating from one of the eight ASI inputs or the Ethernet input. 

 

 
Figure 3-5: Active Output Tab 
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3.2.2.1. Active Output Buttons 
Start:  This button starts the output of the ASI stream. 
 
Stop:  This button stops the output of the active ASI stream. 
 
Save:  This button saves the current configuration to flash memory.  
 
Load:  This button loads the previously saved configuration.    
 
Auto Refresh: If this button is set to ON, the active output will be automatically refreshed.  If this button 

is set to OFF, it will not auto-refresh.  
 
Refresh Rate:  This field sets the refresh rate of the active output.  Using the drop down menu, the 

user can set the refresh rate to 10000ms, 1000ms or 500ms 
 

3.2.3. Preset Tab 
Selecting the Preset Tab enables the user to manage the flash memory by deleting existing content, 
importing presets or exporting previously saved presets.  
 

 
Figure 3-6: Preset Tab 
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List of Presets: This field displays a list of existing presets.  For example, if a preset is imported, it will 
be listed in this field.   

 
Delete:  This button enables the user to delete an existing configuration. To delete a preset 

select the preset file name from the List of Presets and click on the Delete button. 
 
Import:  This button imports presets to local flash memory.  
 
Export:  This button exports presets from flash memory.  
 
Refresh:  This button retrieves the content from the local flash memory. 
 
Compact Flash Present:  This field displays whether the compact flash is present or not present.  
 

3.2.4. Input and Output Faults 
The Input Faults and Output Faults tabs enable the user to view and modify the input and output traps. 
Figure 3-7 displays the input and output traps for the 7780MUX8x2-ASI.  
 

3.2.4.1. Input Faults 
Input Trap Enable:  The input trap enable permits the user to customize whether or not to send an 

alarm when the input is inactive. 
 
Input Trap Status:  The input trap status provides a quick visual overview of the input status.  The 

status will display whether or not the input is active.  
 

3.2.4.2. Output Faults 
Output Trap Enable:  The output trap enable permits the user to customize whether or not to send an 

alarm when the output has stopped. 
 
Output Fault Status: The output fault status provides a quick visual overview of the output status.  The 

status will display whether or not the output has stopped.  
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Figure 3-7: Input and Output Faults 

 

3.2.5. Adding a Program to the MUX Output 
1. Select Output1 from the Outputs folder. See Figure 3-8, step 1. 
2. Select an active input from the Inputs folder.  This input should be one from which you would 

like to add a program. See Figure 3-8, step 2. 
3. Once the Input configuration appears, highlight the program that you would like to add to the 

output. See Figure 3-8, step 3. 
4. Drag and drop the highlighted program into the output configuration window. See Figure 3-8, 

step 4. 
 

 

To add an entire input to the MUX output, select the desired input(s) from the 
Inputs folder and drag the highlighted input(s) into the output configuration 
window.  
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Figure 3-8: Adding a Program to a MUX Output 

 
5. To add additional programs to the output, repeat steps 2 to 4.  
6. Once all desired programs have been added, select an output bit rate in the Config Output tab. 

See Figure 3-9, step 6.  
7. Enter the output TS ID.  
8. Enter the output packet size. 
9. Enter the output mode.  
10. Enter the output table source.  
11. When all the desired settings have been entered, press the Apply button to start the MUX. See 

Figure 3-9, step 11. 
 

 
Note: Once the Apply button is selected, the configured output will be applied 
and transferred to the Active Output window.  
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Figure 3-9: Identifying the Output Properties 
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3.2.6. Adding Individual PIDs to the MUX Output 
If you wish to add individual PIDS to the MUX, select the PID from the list in the General Input Settings 
window and press the Add PID button. The input will be added to Output1. See Figure 3-10.  
 

  
Figure 3-10: Adding PID to MUX Output 
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4. TECHNICAL DESCRIPTION 

4.1. SPECIFICATIONS 

4.1.1. Inputs and Outputs per switch 

• 8 x ASI inputs per TR 101 891  
o Min ASI bitrate: 100 Kb/s per input 
o Max ASI bitrate: 200 Mb/s per input 

• 2 x ASI outputs per TR 101 891 (Mirrored) 
o Min ASI bitrate: 100Kb/s 
o Max ASI bitrate: 100Mb/s 

 
• 1 x RJ45 Input10/100/1000 for DVB-SI and ATSC PSIP 
 
• 1 x RJ45 10/100/1000 control port 

 

4.1.2. Processing 

• PID re-mapping 
• Basic table generation: PAT/PMT/NIT 
• DVB-SI Table insertion up to 2Mb/s 
• ATSC-PSIP Table insertion up to 2Mb/s 

 

4.1.3. Electrical 
Power:   41W 

 

4.1.4. Physical 
Number of Slots:  3 
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5. TROUBLESHOOTING 

5.1. VLPRO DOES NOT DISPLAY THE 7780MUX8X2-ASI ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
established check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

5.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 5-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 5-2, simply navigate to the location of the new JAR file and 
select the file by double clicking it. The window will automatically close and the update will be applied in 
the background.  
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Figure 5-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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6. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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